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Read Me First 
 
Welcome to Take Control of Safari 5, version 1.0, published in 
November 2010, by TidBITS Publishing Inc. This book was written 
by Sharon Zardetto and edited by Tonya Engst, with an assist from 
Michael E. Cohen. 

This book shows you how to make the most of Safari 5, a deceptively 
powerful Web browser with features you may have never even tried. 

Copyright © 2010, Sharon Zardetto. All rights reserved. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to buy 
a new copy to read it more carefully or to keep it for reference.  

Discounted classroom and Mac user group copies are also available. 

UPDATES AND MORE 
You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end of the book; it’s available only to pur-
chasers). On the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB 
and Mobipocket. (Learn about reading this ebook on handheld 
devices at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top 
of the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 
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BASICS 
There are only a few basic items you need to know to make your 
“reading experience” smoother: 

• Menu references: The general “shorthand” description to refer 
to choosing something from a menu is, for instance, File > Open. 
Occasionally a command’s name changes partially to match its 
context; I describe these commands with an obvious placeholder 
such as File > Sync TheDevice. 

• Path names: The route you take to a file on your hard drive, 
whether by looking through columns in a window or by double-
clicking your way through folders, is the file’s path, and there’s 
a standard “syntax” for referring to these paths. 

The disk’s name is always the first thing in a path; we assume the 
disk is always there, so we don’t include its name, but we preserve 
the slash that would separate it from the next item. So, HardDrive/ 
System/Library becomes /System/Library. 

A path to something in a user’s home directory starts with the 
drive’s name, followed by Users and then the user’s name. The con-
vention, however, is to replace those first three items with ~ (tilde), 
so HardDrive/Users/Miriam/Library becomes simply ~/Library. 
(You’ve probably noticed by now that path text is formatted in 
special type.) 

• System Preferences: To work with System Preferences, choose 
System Preferences from the Apple () menu and in the window 
that opens, click the icon for the settings you want to adjust. I 
describe this procedure simply as, for instance, “Open the Parental 
Controls preference pane” or “In System Preferences, open Parental 
Controls.” 

• Safari Preferences: Applications have their own preferences, 
separate from System Preferences. In Safari, choose Safari > 
Preferences (Command-Comma), then access a specific type of 
preference—such as General, Bookmarks, or RSS—by clicking its 
icon at the top of the Preferences window. Sometimes I refer to 
a Safari preference pane as “Safari’s General preferences” or “the 
Bookmarks pane of Safari’s preferences.” 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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• Contextual menus: When I refer to accessing a contextual 
menu, I usually write “Control-click [whatever] for the contextual 
menu…”. This is a little ironic since I never Control-click—my main 
computer is a laptop, and I use a two-finger tap for a contextual 
menu. You might do the same, or you may be using a mouse that’s 
programmed to open a contextual menu with a right-click. When-
ever you read “Control-click” or “right-click,” use whatever method 
you like to open a contextual menu. 

WHAT’S NEW IN SAFARI 5 
As happened with Safari 4, many of Safari 5’s new features are 
background improvements—such as increased page-loading speed—
that can enhance your browsing experience but don’t require any 
action (or learning) on your part. And, from a user’s point of view, 
Safari 5 is so similar to its predecessor that you can transition to it 
with neither fuss nor muss.  

Yet Safari 5 does offer new features that, if not revolutionary, are 
evolutionary in Safari’s development. 

What’s “new”? Sometimes “new” is in the eye of the user. The fea-
tures described here were introduced in Safari 5, but some (notably 
absent: Reader and Extensions) were also added to the Safari 4.1 
update, released at the same time as Safari 5 for users of Mac OS X 
10.4 Tiger. So, if you worked with Safari 4.1 before moving to Safari 
5, some items won’t be entirely new to you. In some places in this 
book, when I say “new in Safari 5,” the feature may also have been 
incorporated into Safari 4.1. 

The invisible new features: 
• The Nitro Engine: One day guys will run out of ways to describe 

souped-up engines: turbo-charged, super-charged, nitro… 
whatever! Safari 5’s under-the-hood browsing power is called the 
“Nitro Engine,” and it is supposed to provide a 30 percent increase 
over Safari 4’s page-loading speed. We can assume that our mileage 
will vary. 

• Prefetching and caching: Yes, it sounds like a Letterman 
“Stupid Pet Trick,” but “prefetching” is a clever way to increase your 
perceived page-loading speed as you go from one page to another. 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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While you’re looking at one page, Safari scans it for links and looks 
up the DNS entry (the actual location of a page) for each, in case 
you click one. Improved caching (storing the pages you visit) should 
get you back to a previous location more quickly than in Safari 4. 

• New HTML support: This isn’t exactly invisible, since it’s all 
about seeing content on a page, but neither is it something you 
control or tweak. It just is—as long as Web pages use it. There’s 
support for new, cutting-edge HTML5 features for typography, 
video, and graphics (transitions, gallery options, and virtual-reality 
viewing). Check out the mouth-watering examples at 
http://www.apple.com/html5/. These samples are proof that the 
Web can be an incredibly visually rich place without Flash, but until 
other browsers also fully support these standards, you might not be 
able to enjoy anything except examples. 

The visible new major features: 
The main new features in Safari 5 are: 

• Reader: By far my favorite new feature, Reader lets you see the 
main article on a Web page, relegating annoying ads and other 
distracting material to a darkened background. “Read” all about 
it in Tune Out Page Clutter with Reader. 

• Extensions: Yess! I know so many people who opt for Firefox or 
Chrome as their main browser solely because previous versions of 
Safari didn’t provide for “extensions”: add-ons that tweak Safari’s 
capabilities. Learn how to add extensions with Expand Safari’s 
Capabilities with Extensions. 

• Choice of search engine: While the search field still defaults to 
Google, you can change the default to Bing or Yahoo, and you can 
easily switch from one to another at any point in a search. Get the 
details from Know Your Search Options. 

Other new features: 
Safari 5 has many small improvements, some of which are subtle and 
therefore all the more pleasant to run across, such as: 

• For the address field: A more wide-ranging suggestion list for 
the address field and the return of the blue progress bar, described 
in Use the Address Field. 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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• For the toolbar: You can Define “Permanent” Buttons for Narrow 
Windows to keep your most important buttons on the toolbar. 

• For Top Sites: New buttons at the top of the Top Sites window 
(Manage Your Top Sites) and another option for adding something 
to that gallery (Add a Page to Top Sites). 

• For tabs: In the little-things-mean-a-lot department, there’s finally 
a way to reopen an accidentally closed tab, described in Reopen 
Recently Closed Windows or Tabs.  

WHAT’S NEW IN THIS EDITION 
The last edition of this book was all about Safari 4, and now here we 
are in Safari 5. So, of course, all the links in What’s New in Safari 5 
(the previous topic) point you to new material. 

But this edition is almost 50 percent bigger not just because of the 
new-feature coverage, but also because I’ve expanded some topics 
considerably, and added some that weren’t in the previous version: 

• When there are many ways to do something: There are many 
ways to do the same (or very similar) things in Safari, whether it’s 
creating tabs or scrolling the window contents. I’ve added some new 
information and tables to cover multi-option procedures so you can 
more easily see the choices and decide what works best for you: 

◊ Table 3: Keyboard Shortcuts for Moving between Windows, 
Tabs, and Recent Pages 

◊ Scroll the Safari Window 

◊ Appendix B: Trackpad Gestures in Safari 

On a related issue, many items hide amazing multi-purpose func-
tionality, as proved by Use the Back and Forward Buttons and 
Menus and Tabs, Tabs, Everywhere. 

• More about preferences: So many preferences, so little time! 
Sometimes it’s easier for someone to walk you through what’s-
probably-best-for-you preference settings and then you can tweak 
them later to match your needs. I’ve expanded Set Your RSS 
Preferences and Define Your History Range with more info, and 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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I’ve added Set Your Tab Preferences and Set Your Bookmark 
Preferences. 

• More general information: A little background information 
never hurts, and it usually helps, so I’ve added C is for Cookie and 
Safari’s Page Cache, as well as expanded the basic information in:  

◊ Reload a Page 

◊ Cancel a Page Load 

◊ Utilize the Downloads Window 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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Introduction 
 

 
Why do you need a book about Safari? You’ve been using Safari for 
what seems like eons, and you’re doing just fine. 

But you don’t have to settle for “fine.” In all likelihood, Safari does 
far more than you’ve been asking it to, and those things you have been 
doing with it you can do more quickly, elegantly, and efficiently when 
you know Safari’s ins and outs. I can vouch for that because when 
Safari 4’s beta version was released, I vowed to finally, finally, explore 
Safari thoroughly, in order to find the best way to organize bookmarks, 
give it another chance as an RSS reader, learn about tab options 
instead of using them in the most obvious way—oh, and deal with the 
pesky issue of having dismissed the offer to save a password for a site 
and never again being asked to do so. 

So, when Safari 5 was released, practically under the radar because of 
the contemporaneous release of the iPhone 4, I was all set to probe the 
existing features for subtle changes, as well as explore the major new 
ones (Reader and Safari extensions).  

Because I’ve devoted so much time to this, you don’t have to! You 
won’t have to learn bits and pieces from various sources, experiment 
on your own, or click your way through the not-exceptionally-helpful 
Help system to put together disconnected tidbits of information. 

Whether you have been using Safari 5 for a while or are about to 
upgrade to it, this book is for you. No matter how you use Safari—for 
lightweight general surfing, or middleweight targeted browsing with 
(a probably disorganized pile of) bookmarks—this book will take you 
to the heavyweight division, with toned tabs, a buffed bookmarks bar, 
ad-free main-article reading, total control over RSS feeds, and more. 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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Safari 5 Quick Start 
 
The material in this book is the least linear of any Mac book I’ve 
ever written: there are few interdependencies among the topics, 
so you can start with any one that piques your interest or is likely to 
answer the burning questions you have about using Safari—whether 
they’re of longstanding duration or specifically about Safari 5. 
Luckily, ebook links lend themselves to just that sort of approach! 

On the other hand, if you don’t want to accidentally miss anything, 
just follow the advice given to Alice: “Begin at the beginning and go 
on till you come to the end: then stop.” 

 

Download and install Safari 5: 
• If you haven’t moved to Safari 5 yet, read Appendix A: Update to 

Safari 5. The appendix shows you how easy it is to do so, and it 
discusses the system requirements for the upgrade. 

Check out Safari 5’s new features:  
• If you want to hit the highlights of new features, use the links in 

What’s New in Safari 5. The two major new features are covered in 
Tune Out Page Clutter with Reader and Expand Safari’s Capabilities 
with Extensions. 

Customize your experience: 
• From top (the toolbar) to bottom (the status bar), you can tweak 

Safari’s looks and basic behavior—see Customize Your Safari 
Environment. For more advanced customization, find out how 
to Organize the Bookmarks Bar and how to Expand Safari’s 
Capabilities with Extensions. 

• Set your Safari preferences. Its various preference panes are 
covered in their topic areas, such as:  

◊ Define Font Parameters 

◊ Set Your Tab Preferences 

◊ Override a Page’s Default Window-Opening Settings 

◊ Know Your Link-Opening Options 

◊ Set Your Bookmark Preferences 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU11689567046&PT=TRK-0111-SAMPLE


11 

◊ Define Your History Range 

◊ C is for Cookie 

◊ Turn on AutoFill Sources 

◊ Set the Download Preferences 

◊ Set Your RSS Preferences 

◊ Install Extensions 

Learn key browsing techniques: 
• You know the basics, but you can learn their details in: 

◊ Navigate to and within Web Sites 

◊ Track Your Downloads 

◊ Use AutoFill for Forms and Passwords 

◊ Scan Site Highlights with RSS Feeds 

• See how you can read an “article” without ads distracting you or 
having to click from one page to the next when it’s split across 
several pages in Tune Out Page Clutter with Reader. 

• Juggle multiple sites with finesse by learning how to Handle 
Multiple Pages with Window Tabs. 

• Read about the differences in the ways your previously visited Web 
sites are stored automatically or manually in Go Back to Where 
You’ve Been. Explore the details for each of the methods in Manage 
Your Top Sites, Set Up and Use Bookmarks, and Retrace Your Steps 
through History. 

• Protect your privacy: Store and Edit Your Passwords, and learn 
about Stealth Browsing and how to Erase Your Tracks with the 
Reset Command. 

• Optimize your search techniques in various areas with: 

◊ Use the Web Search Field 

◊ Search within a Page 

◊ Search Your History and Bookmarks 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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Customize Your 
Safari Environment 
 
From top (the toolbar and bookmarks bar) to bottom (the status 
bar), and several things in between (such as starting pages), you 
have some choices as to how Safari’s window looks and behaves. 
In this chapter, I show you the most important ways to customize 
Safari when you start using it. I cover many other customization 
options throughout this ebook. 

DO BASIC SETUP FOR THE “BARS” 
The top of the Safari window has, directly beneath its title bar, the 
toolbar, tabs (in the “tab bar”), and the bookmarks bar; at the bottom 
of the window is the lowly status bar (Figure 1). 

 
Figure 1: The top “bars” don’t look separate, but different areas 
provide different functionality. From top to bottom: the title bar, 
the toolbar, the bookmarks bar, the tab bar, and the status bar. 

You can make the bars come and go pretty much as you please (you 
can’t hide the tab bar when the window has tabs): use the Hide/Show 
commands in the View menu (Figure 2). On a big screen, there’s no 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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Navigate to and 
within Web Sites 
 
In life, the journey may be the reward, but when you’re surfing 
the Web, it’s the destination that counts. In this section, I explain 
how to get there quickly and move among various “theres” with a 
minimum of effort. 

USE THE ADDRESS FIELD 
Typing a URL (Universal Resource Locator, a Web site’s “address”) 
into Safari’s address field and pressing Return takes you directly to 
that page. But if you’ve been to the site previously, you won’t have to 
type the entire URL because of Safari’s “smart address field.” 

The smart address field can jump to a conclusion if you type any part 
of a page’s: 

• URL: The page’s address, such as 
http://www.takecontrolbooks.com/snow-leopard-fonts. 

• Title: This is what appears in the Safari window’s title bar, based 
on the Web designer’s name for the page. The page at http://www. 
takecontrolbooks.com/snow-leopard-fonts has the title “Take 
Control of Fonts in Snow Leopard.” 

• Name: If you’ve saved a bookmark for a page, the name you gave to 
the bookmark is also a candidate for the smart address field. 

If Safari recognizes what you’re typing in the address field, it completes 
the name of the most likely match (Figure 6), so all you have to do is 
hit Return to go to the suggested page. 

In older versions of Safari (until Safari 4.1) the text you entered in 
this field had to match the beginning of a suggested URL (disregarding 
the http://www. prefix.) So, typing apple could suggest apple.com 
and applepie.com, but not OneBadApple.com. Now, if you type apple 
in the address field, Safari can not only suggest the OneBadApple site 
because “apple” is included in the name, but also offer any page in your 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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Manage Your Top Sites 
 
Safari is Big Brother-ish in a good way: it keeps track of where 
you’ve been, and how often and how recently you’ve been there, 
and cleverly calculates a Top Sites list stripped of such distractions 
as sign-in pages and multiple pages from the same site. 

The presentation of Top Sites can be deceiving: more than just eye 
candy, it provides a way to scan multiple, identifiable thumbnails in 
an instant; you’ll wish you could view your bookmarks and history 
in the same way—if only it could display more than two dozen items. 

VIEW YOUR TOP SITES 
See your Top Sites by choosing View > Top Sites (Command-Option-1) 
or by clicking the Top Sites button in the toolbar or bookmarks bar. 
The sites are displayed in a curved gallery of thumbnails; any page 
whose content has changed since you last visited is flagged with a 
can’t-miss white star on a blue background (Figure 10). Go to a page 
by clicking its thumbnail; it expands to fill the screen, but is slightly 
dimmed until it’s updated from the site. 

No Top Sites button? Add the button to the toolbar through the 
Customize Toolbar command (described in The Toolbar) or to the 
bookmarks bar through Safari’s Bookmark preference pane (select 
Include Top Sites).  

Safari 5 added buttons at the top of the Top Sites screen (also shown 
in Figure 10) that let you flip between Top Sites and a special History 
view—but it’s not special in a good way! While the Top Sites screen 
shows you the calculated “these are the places you’re likely to want to 
revisit” pages, this History view shows everything in your browsing 
history, in a giant-thumbnail view with no text list beneath it; this 
makes it very difficult to scan through more than the most recent 
pages. You’re better off viewing your history in the Bookmarks win-
dow, as described in Retrace Your Steps through History. The Search 
History field on the Top Sites and this History screen show results in 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU11689567046&PT=TRK-0111-SAMPLE


38 

Handle Multiple 
Pages with Tabs 
 
I’m always surprised at the number of users who disdain to use tabs 
because they assume the feature is a useless add-on. But window 
tabs are possibly the best thing since sliced bread; come to think of 
it, they’re sort of like sliced window. 

Tabs let you keep multiple Web pages open in a single window; this 
is especially useful on a laptop with limited screen real estate, but it 
keeps window-juggling to a minimum on any screen. And, tabs pro-
vide a convenient organizational tool: you can, for instance, have 
several windows open, each with a subset of related Web pages in 
tabs, when you’re researching a topic—whether the topic is global 
warming or which wireless Bluetooth speaker you should order from 
Amazon.com. 

SET YOUR TAB PREFERENCES 
Whether you’ve been using tabs all along, or are about to explore their 
usefulness, set up your tab preferences. If you have no personal pref-
erences, start with my recommendations for the options: 

1. Choose Safari > Preferences and click the Tabs button. 

2. From the Open Pages in Tabs Instead of Windows menu, choose 
Automatically. This option, new in Safari 5, is detailed in Override 
a Page’s Default Window-Opening Settings, ahead in this chapter. 

3. Check the Command-Click Opens a Link in a New Tab option. Enter 
the twenty-first century if you haven’t yet; this is the standard for 
opening tabs. (See Tabs, Tabs, Everywhere to learn how this setting 
affects more than just links.) 

4. Uncheck the When a New Tab or Window Opens, Make It Active 
checkbox. One of the advantages of tabs is that you can Command-
click a dozen links on the page you’re reading, lining up a bunch of 
tabbed pages that you can then read, without having to move back 

Click here to buy the full 136-page “Take Control of Safari 5” for only $10!
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Tune Out Page 
Clutter with Reader 
 
Reader is my favorite new feature in Safari 5. It lets you easily read 
the main text on a Web site by consigning surrounding text, buttons, 
menus and—especially and—ads to a dark oblivion behind a special 
reading window. In addition, it uses an easy-to-read font with good 
line spacing, no matter what fonts the page’s designer chose to 
impress you. As an extra bonus, it grabs all the text of an “article” 
into a single reading window, even when it’s spread across several 
pages. Perfect for not only reading, but for printing or emailing, too. 

LEARN READER BASICS 
Before you learn how to use Reader, you should understand that it 
doesn’t work on every Web page. The page must have what can be 
considered a main “article,” something that’s identified by Safari as 
such, based on the background Web page code and the length of the 
text. (There’s no code that’s specific to Reader; it looks at the standard 
HTML coding of a page.) So, if you go to something like the home page 
of Wikipedia (http://en.wikipedia.org/wiki/Main_Page) or the New 
York Times (http://www.nytimes.com/), you won’t be able to use 
Reader, because those pages are a conglomerate of short pieces, none 
of which qualify as a main article. But, as soon as you click a link to 
read one of the stories “blurbed” on the top page, you can use Reader. 
(Amusingly enough, I’ve yet to find a single place on Apple’s Web site 
that Reader can use!) 

How can you tell when Reader’s available? You’ll see a Reader button 
in the address field (Figure 16)—you can’t miss it! 
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Set Up and 
Use Bookmarks 
 
Bookmarks are, at heart, simple things: pointers to pages you 
want to revisit. But their flexibility—the different ways you can 
store and access them, how they interact with tabs—make them 
far from simple tools.  

I used to keep very few bookmarks on my bookmarks bar, and 
most of the rest in what amounted to a big pile (nothing in folders 
or subfolders), with little or no renaming of my bookmarks from 
their default, often long-winded, titles. I bookmarked a lot of sites, 
yet rarely used the bookmarks to go back to them because the lack 
of organization made it too much of a bother—I wound googling 
to find them again. 

Once I started exploring bookmark options and discovered their 
versatility and power, however, I was converted—and now I’m 
proselytizing. Knowing how convenient bookmarks have made 
my browsing has encouraged me to become, and stay, organized—
a philosophy I have yet to apply to my closets. Naming a bookmark 
and putting it in a certain folder when I first save it has become 
second nature to me in a very short time. (I still have a catch-all 
bookmark folder for when I’m in a hurry or don’t know exactly 
where something should go—just like I have a junk drawer in the 
kitchen. And in the dining room. And in almost every other room.) 

SET YOUR BOOKMARK PREFERENCES 
The Safari Preferences window has an entire pane devoted to 
Bookmarks (Figure 19), and two bookmark-related settings in the 
RSS pane.  
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Retrace Your Steps 
through History 
 
You certainly don’t remember all the places you’ve been on the 
Web, but Safari does, and it provides a myriad of ways for you to 
return to almost any site you’ve ever visited. Maybe you want to 
return to page that you clicked away from ten links ago (and then 
jump back to that tenth page); perhaps you want to return to a blog 
you read last month but didn’t bookmark for easy reference. Or 
maybe you just closed a multi-tabbed window and want it all back. 
Safari can help you with those situations, and others. 

 
Your overall browsing history is tracked by a series of bookmarks—one 
for every page you view (yes, every page, not every site!). These history 
bookmarks are divided into subsets for each day and are available from 
the History menu and its submenus, as well as from within the 
Bookmarks window through the History collection. 

There is also a more ephemeral, and very convenient, history recorded 
for each window and tab you work in. 

History bookmarks? What’s the difference between the bookmarks 
you create and history bookmarks? Just that you create your own 
bookmarks for pages to which you’d like to return, and put them in 
various easy-to-access places, while Safari automatically bookmarks 
every single page you visit and puts them in the History collection. 

DEFINE YOUR HISTORY RANGE 
Set the limit for how long your history lasts with the Remove History 
Items menu in the General pane of Safari Preferences (Figure 27). In 
the absence of any choice between the too-short one-month option and 
the perhaps too-long one-year option—four to six months would feel 
about right!—I suggest you choose After One Year. 
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Know Your Search 
Options 
 
Safari offers three distinct types of searching: across the vast Web, 
within the currently displayed Web page, and through the titles and 
content of the pages in your history and bookmarks collections. 

USE THE WEB SEARCH FIELD 
Safari has long used Google as its built-in Web search engine of 
choice: the search field in the toolbar searched through Google. 
With the Apple-Google honeymoon apparently over, we now have 
two additional choices for the search field: Yahoo and Bing. 

Although Google is still the default choice, you can change it either in 
the General pane of Safari’s Preferences or from the Safari window’s 
toolbar (Figure 30).  

 
Figure 30: An inactive search field shows the name of the current 
search engine; it also lists previous search terms if you haven’t 
cleared them (as shown in Figure 31). You can easily switch to 
another search engine by choosing it from the search field’s menu.  

To use the search field, just type in it and then either press Return 
to start the search, or select something from the suggestion list that 
appears. You can activate the field for typing by clicking in it or with 
Command-Option-F.  
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Use AutoFill for 
Forms and Passwords 
 
Safari’s AutoFill feature helps fill in the blanks on Web pages—for 
forms and even user name and password information. It uses infor-
mation from the sources you’ve allowed, and it can fill in fields on 
a Web page one at a time or in one fell swoop. 

TURN ON AUTOFILL SOURCES 
Safari can gather form-filling information from three sources, but you 
have to tell it which ones it’s allowed to use: 

1. Open Safari Preferences and click AutoFill (Figure 35). 

 
Figure 35: The Edit buttons in AutoFill are somewhat misleading: 
only the first lets you edit information, by opening your card in 
Address Book. The other two open lists for which your only editing 
option is deleting entries. 

2. For the most complete AutoFill behavior, check all the choices: 

• Using info from my Address Book card: Your “me” card in 
Address Book can store the frequently asked-for basics of name, 
address, phone, and email. 

This card should have been automatically created as part of your 
Mac OS X setup. Look in Address Book (it’s in your Applications 
folder) for a card with your name on it, and a small white-on-
gray “me” stamp in the lower left corner of your account icon at 
the top of the card. If there’s no “me” card, make a new card, fill 
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Track Your Downloads 
 
Most of us don’t give a second thought to downloads: click a link, 
download, perhaps have the download auto-open, and move on. A 
little attention to the details, however, never hurts—and might help. 

SET THE DOWNLOAD PREFERENCES 
There are three download-related items in the General pane of Safari 
Preferences (Figure 37). 

 
Figure 37: Default (and also the recommended) settings for 
download-related items in Safari Preferences. 

These options are best left at their defaults: 

• Save downloaded files to: The default Downloads folder is the 
logical place; the only reason to change the download location is to 
prevent the commingling of Web downloads and email attachments 
from Apple Mail, both of which use this folder as a default—but I 
recommend changing Mail’s download folder instead. (Do you think 
of email attachments as “downloads”?) 

Tip: Keep your Downloads folder in the Dock. It bounces once 
when a download is complete—a nice little alert—and you can 
use the folder’s Grid view to see downloaded items conveniently 
if you sort it by Date Added. (Control-click the Downloads Dock 
icon for its contextual menu, and choose Grid; open the con-
textual menu again, and choose Date Added.) 
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Scan Site Highlights 
with RSS Feeds 
 
An RSS (“Really Simple Syndication”) feed lets you check out a Web 
site’s contents the way you might scan newspaper headlines, quickly 
deciding which information you want to read in depth—if the site’s 
designer has included RSS capabilities. 

Most RSS feeds offer the first few lines or a hand-tooled synopsis 
of an item, with a Read More link to get you to the full version; some 
include the full text of each article. In both cases, however, you get 
a series of text-based items without the rest of the Web site, with its 
graphics, buttons, and links (and ads). 

In Safari, you can view RSS feeds whenever you’re on a site that 
offers them, or you can store your favorite sources as bookmarks 
so you can return to them for frequent updates. 

You can also use Apple Mail to handle RSS feeds, and there are 
several utilities—called “readers”—that offer different, and often 
better, ways to juggle hundreds of feeds, if you are so inclined. 

 

RSS reader vs. Reader: Thanks, Apple, for muddying the Safari-
terminology water! A “reader” with a lowercase R is what you use 
to view RSS feeds. But “Reader” with a capital R is Safari 5’s new 
Reader feature (see Tune Out Page Clutter with Reader). 

SET YOUR RSS PREFERENCES 
Safari offers many preference settings for handling RSS feeds. The RSS 
pane of Safari’s preferences starts with the Default RSS reader pop-up 
menu, which changes based on which readers you have available 
(Figure 40). It always includes Safari and Mail; in addition, it lists 
any other readers on your Mac. (It seems that Safari can find them 
almost anywhere on your drive; the readers shown in the figure were 
all still in my Downloads folder!)  
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Expand 
Safari’s Capabilities 
with Extensions 
 
Extensions are small programs that extend Safari’s functionality 
by adding missing features or improving existing ones. The addition 
could be as tiny as adding a Reload button to the toolbar (if you 
don’t like using the one inside the address field). Or, it could be 
much larger, and more useful: blocking annoying ads from appear-
ing, letting you navigate from one link to another on a page using 
just the keyboard, providing previews of Web pages on a Google 
results page—or adding an entire bar at the top of the Safari window 
to display a news feed or Twitter messages. The extensions feature, 
long demanded by many users, was introduced in Safari 5.0.1. 

Apple’s Extensions Gallery is the official hub for Safari extensions, 
but others are available directly from developers.  

INSTALL EXTENSIONS 
You can download and install extensions both from Apple’s Extensions 
Gallery and from developers’ Web sites. What’s the difference? A layer 
of security. Extensions in the Gallery get a signed digital certificate 
from Apple, which ensures that any updates come from the original 
developer. Also, through a practice called “sandboxing,” Gallery exten-
sions are designed so that they can interact only with Safari, and can’t 
talk to your operating system or secretly give information to Web sites 
(some extensions are supposed to provide Web sites with 
information—but not secretly).  

Safari’s extensions capability is turned on by default, but to make sure 
you have it turned on: 

1. In Safari, choose Safari > Preferences and click the Extensions 
button. 

2. Click the Off/On button to On if necessary. 
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Appendix A: 
Update to Safari 5 
 
Updating from Safari 4 to Safari 5 is a cinch, but you must meet 
the basic system requirements—which means if you’re using 
Mac OS X 10.4 .x Tiger, you must stay with Safari 4. If you’re using 
10.5.x Leopard or 10.6.x Snow Leopard, you may have to update 
your operating system software to the minimum version that 
supports Safari 5. 

And, Safari itself must be updated at intervals: the initial release 
of Safari 5 was updated to version 5.0.1 within weeks, and you need 
at least that version in order to use extensions. 

Automatic software updating is controlled by the Software Update 
preference pane, where you can set how often the Mac checks for 
updates and whether downloading them happens automatically or 
waits for your approval. So, depending on your settings, your Mac 
may have already guided you through the download, and even the 
installation, of your required system updates and Safari 5. 

If your settings are such that you manually check for and download 
updates (and you’ve avoided some of them), this section tells you 
how to upgrade to Safari 5. 

SYSTEM REQUIREMENTS 
The minimum system-version requirements for Safari 5 are: 

• Snow Leopard: 10.6.2 

• Leopard: 10.5.8 

Check your current system version by choosing Apple () > About 
This Mac; the version number appears in the About window. 

The Mac won’t install Safari 5 unless your system software is updated 
to accommodate it. If you’re behind the curve on your version of Mac 
OS X, set aside a goodly chunk of time for updating: the combination 
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Appendix B: Trackpad 
Gestures in Safari 
 
I moved up to a new MacBook Pro with the latest gesture-enabled 
trackpad features at about the same time Safari 5 came out, and I 
was looking forward to a swipe-gesture method of moving from one 
tab to another. So far, that’s still not possible. But there are many 
other trackpad gestures that you can use in Safari; they’re noted in 
their topic areas throughout this book, and rounded up here. 

 
The trackpad gestures that are available to you depends on which 
laptop model you have. Check the Trackpad preferences in System 
Preferences to see if you have, for instance, three-finger swiping avail-
able and to turn on (or off) the various trackpad capabilities. (You have 
a Magic Trackpad? It has all the capabilities mentioned here, but they 
still must be enabled in Trackpad preferences.) 

• Scroll the window: As with all other windows on your Mac, you 
can use a two-finger swipe to scroll vertically. Recent-model track-
pads, with “inertial scrolling,” keep the window scrolling, finally 
slowing it to a stop, after your fingers are off the trackpad. (This is 
particularly handy when you’re looking through the thumbnails in 
the Bookmarks window.) 

• Increase/decrease the size of the window contents: When 
you pinch your fingers apart or together, you won’t see a smooth 
change in size as you do on the iPad, iPhone, or iPod touch; you’ll 
get the same step-up or step-down in size as when you choose 
View > Zoom In (Command-plus) or Zoom Out (Command-minus). 
And, as with those commands, the Zoom Text Only setting—
described in Supersize Me—affects whether images change size, too. 

• Move to the previous or next page: You can use three-finger 
swipes instead of clicking the Back and Forward buttons (detailed 
in Move between Windows, Tabs, or Recent Pages). A left swipe 
is Back/Previous and a right swipe is Forward/Next; the Back or 
Forward button highlights as you swipe.  
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Appendix C: Create 
a Web-Clip Widget 
 
If you use Dashboard a lot, you’ll find it convenient to have a Web 
page snippet, or “clip,” as a widget for quick reference, whether it’s 
tomorrow’s weather, today’s stocks, or something like a joke-of-the-
day. (Don’t use Dashboard? Don’t know what it is? It’s an appli-
cation, on your Dock by default but also in your Applications folder, 
that displays a bunch of tiny applications, called widgets, that do 
everything from tracking the weather to checking what’s in your 
local movie theaters to—of course—letting you play games.) 

 
To create a widget from part of a Web page: 

1. Go to the Web page you want to clip. 

2. Choose File > Open in Dashboard, or click the Open in Dashboard 
button if it’s on your toolbar.  

The Web page dims and a large bright patch follows your cursor 
around (Figure 54). 

 
Figure 54: When you’re in “clip” mode (left), a white rectangle follows 
the cursor and snaps to an article’s size when you pass over it (right). 
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About This Book 
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. 

EBOOK EXTRAS 
You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB and 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top of 
the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 

ABOUT THE AUTHOR 
It’s hard to believe that I’ve been writing about computers since before 
the Mac was born. There were personal computers before the Mac? Ah, 
yes, my first: the Timex-Sinclair with its 2K of RAM (that’s not a typo, 
and it was a thrill when the 16K RAM pack became available) and 
cassette-tape storage. Good old days? Not by a long shot! 

But I’ve been writing about the Mac since it arrived on the scene—
hundreds of print articles, twenty or so (paper) books, and now 
electronic-based dissemination of Mac info—and haven’t tired of it 
yet (and I tend to become bored rather easily). We generally have 
about three times as many computers in the house as people, along 
with such necessities as a Time Capsule, an iPad, iPod touches, and 
so on—and are at this point eagerly awaiting the Verizon iPhones.  
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In addition to a university-professor husband whose Macophilia rivals 
my own, I have two grown sons occasionally back in the all-too-briefly 
emptied nest due to the vicissitudes of the economy and job market—
although I’m not sure how at one point they coordinated moving back 
the exact same week. We live in New Jersey, just a few miles outside of 
Manhattan (a statement I add for the comfort of my New-York-born-
and-raised husband—and you should understand that when we say 
“New York” around here, it means New York City, not the state).  

AUTHOR’S ACKNOWLEDGMENTS 
If I say “thanks, as usual” that doesn’t diminish the gratitude. So, 
thanks, as usual, to Tonya Engst for her direction and editing. And her 
friendship. 

Thanks also to Michael E. Cohen—I don’t know what the E stands for 
(I keep forgetting to ask)—for his round of editing. I hope he enjoyed 
the new collaboration as much as I did. How can you not love an editor 
who muses in a margin note: I wonder if the One Ring was Sauron’s 
horcrux? 

Thanks also to Dr. Peter Chan—who won’t be reading this since he’s a 
Windows guy—for putting my wrist back together so I could type. 

SHAMELESS PLUG 
My other current Take Control book is Take Control of Fonts in 
Snow Leopard. Dribs and drabs of useful information go into my 
blogs http://mactipster.wordpress.com/, and 
http://ipadpunditry.wordpress.com/. What little is left of my life can 
be followed on Twitter, where I’m cleverly known as SharonZardetto. 
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Take Control of Apple Mail in Snow Leopard (Joe Kissell): Go under 
the hood with the new (and old) features in Apple Mail 4. Joe gets you 
going and helps you get the most out of Mail. $15 

Take Control of Easy Mac Backups (Joe Kissell): Devise a rock-solid 
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